Configure and Troubleshoot RONA with CCE
CVP
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| ntr oduction

This document describes how to configure and troubleshoot Ring-No-Answer (RONA) with Cisco
Customer Voice Portal (CVP) and Contact Center Enterprise (CCE).

Prerequisites
Requirements

Cisco recommends that you have knowledge of these topics:

Cisco Unified Customer Voice Portal (CVP)

Cisco Unified Contact Center Enterprise (UCCE)
Packaged Unified Contact Center Enterprise (PCCE)
Cisco Unified Comuincations Manager (UCM)

Components Used

The information in this document is based on these software versions:

« CVP126

» UCCE 12.6

* PCCE 12.6

* UCM 125 and later.

The information in this document was created from the devices in a specific lab environment. All of the
devices used in this document started with a cleared (default) configuration. If your network islive, ensure
that you understand the potential impact of any command.



Overview

The RONA functionality ensures that when an agent does not answer a cal, for example because he walked
away from his desk without make himself Not Ready, the call istaken away after the call hasrang for a
configurable number of seconds. The call isthen presented to another agent or put back in queue, and the
agent is put in not ready state. When you use CCE with CV P, the UCM does not control the queue platform
(CVP) and can therefore not send the call back to the CVP for re-queue. Instead, the CV P controls the call
and takes action. The solution isto use the RONA function only to make the agent unavailable when he does
not answer the call and use the ICM Router Requery function to take the call away from the non-answer
agent.

When a solution of CCE application isintegrated with CVP as a queue point and routing client, RONA
needs to be configured differently than when it isintegrated with IP-IVR. The differenceisthat IP-IVR's
call control iswith the UCM, whereas with CVP, the call control iswith the CVP.

Configuration
Ensure that the CVP agent RNA Timeout < CUCM call forward timer.

UCCE - Agent Desk Settings

The agent desk setting needs to be assigned to the agent who is non-auto answer
Step 1. Access Configuration Manager in Adminstrator server.
Step 2. Navigate Tools-> List Tools-> Agent Desk SettingsList .

Step 3.Seelist of Agent Desk Settings if you added already, or you can add those new Agent Desk Settings.



: Agent Desk Settings List

Select filter data Attributes

MName * |P|.G5
Optional Filter Condition Value {Case Sensitive) Fing no answer time I:I seconds (1
|N'3'”IE v | Ring no answer dialed number | <Mone:
[ |save | Retrieve | Cancel filter changes Logout non-activity time seconds (1

Agent Desk Settings Work mode on incoming 1Ir| Required with Wrapup Datz
M ame

Work mode on outgoing 1Ir| Required

Wrap up time seconds (1

Aazsizt call method |Cunsuh

Emergency alert method |D:|nsuh

Description |
Miscellaneous Outbound Ac
[ Auto answer [ ] Intematio
[ ] Idle reason required [] National
[ ] Logout reason required [ Local priv
[ ] Auto record on emergency [] Operator

[ ]PeX
[w] Enable Cisco Unified Mobile Agent
Mabile agent mode Agert chooses

Add | | Delete Fewvert 5

ICM Instance: citi

Note: Agent state set iSREADY or NOT_READY after CVP RNA expires based on the Step 4.
and Step 5. configuration respectively

Step 4. Agent state set isSNOT_READY after CVP RNA expires when:

In Agent Desk Settings, theRing no answer dialed numberfield is set to
blank.

Y ou do not enter avalue in theRing No Answer timefield.



"-: © Agent Desk Settings List

Select filter data Attributes

Mame * |.F'|.GS
Optional Filter Condition Value (Case Sensitive) Ring no answer time |:| seconds (1-
|N'3'”'E ¥ | | | | | Ring no answer dialed number | <Mone:
[]save | Retrieve | |Canu:e| filter changes | Logout non-activity time geconds (10
Agent Desk Settings Work mode on incoming t| Required with Wrapup Data
Mame
Wotk modecnouigong *[Reaured
[+ TEAM
Wrap up time geconds (1 -
Assist call method |Cunsuh
Emergency alertt method | Consutt
Description |
Miscellaneous Outbound Act
[] Ato answer [ ] Intematior
[ ] Idle reason required [ I National
[ ] Logowt reason required [ Local priv
[ ] Aute record on emengency [ Operator
[Irex
[+] Enable Cisco Unfied Mobile Agent
Mabile agent mode |ﬁgent chooses

pdd || Delste || Rever 33

[CM Instance: citi

Step 5 Agent state set iSREADY after CVP RNA expires when:

In Agent Desk Settings, theRing no answer dialed numberfield isset to
blank.

Y ou entered avalue in theRing No Answer timefield. This value must be at
least 2 seconds more than timeout configured at Unified CVP for RNA
Timeout.



Select filter data

Optional Filter Condition Value (Case Sensitive)
|Nune W |
[]save | Retrieve | Cancel filter changes

Aygent Desk Settings

M ame
[ TEAM
Add | | Delete Fevert

Attributes

Mame

*|AGs

Ring no answer time

seconds (1

Ring no answer dialed number | <MNones

Logout non-activity time

Work mode on incoming

e

1Ir| Required with Wrapup Data

Wark mode an outgaing *| Required
Wrap up time seconds (1
Aszsist call method |Cun5uh
Emergency alert method | Consult
Description |
Miscellaneous Cutbound Ac
[] Auto answer [] Intematio
[ ] dle reason required [ National
[ ] Logout reasen required [v] Local priv
[ ] Auto record on emengency [] Operator
[ |PEX
[w] Enable Cisco Unified Mobile Agent
Mabile agent mode Agert chooses
5

[CM Instance: citi

Note: In the example script Scripting for RONA:

1. The Queue node for the skill group that selects the first agent must have Target

Requery enabled.

2. Raise the priority of the call so that it moves to the front of the queue.

PCCE - Agent Desk Setting

Step 1. Open the CCEAdmin and navigate to Desktop.

Step 2. On Desktop select the Desk settings that the agent has configured.



Step 3. Select either Not Ready or Ready on the Agent State after RONA field.

i nified Cortact Center Entemrise Management
cisco et Center Enterprise Manage

Edit DefaultAgentDeskSetings

LA <
Wrapup on Incoming® Requiiesd with wrap-up data s
Wragup on Ouigoing® Reequined w
Wrapup Timer 10

Supenasor Assist Call Corsultatie Ca W
Miat b

Emerngency Call Method Consultative Ca w
Agent State afer ROMA Mod Fleady \.-]

et Beady

Resd
Aauto Answer Mo Ao Answeer w
Resquire kdle Reascn w Requine Logaout Reason ' Enable ACD shasred lire

UAEGE

CVP- OAMP Console (for UCCE only)

Step 1. Access OAMP Web Page.

Step 2. Navigate System -> Dialed Number Pattern.



Cisco Unified Customer Voic

System w| Device Management =  User Mz

Control Center

Device Pool

Import System Configuration
Export System Configuration
Location

SIP Server Groups

Dialed Number Pattern

Web Services

105 Configuration »
WB Configuration

Courtesy Callback

SIP Error Reason Code Mapping

Cloud Services k

Step 3.Seelist of patternsif you added already, or you can add those new end points used for Agent
extension.

E;% Deploy m Deployment Status ? Help

General

List of Dialed Number Patterns

Display Pattern Type: | Display All

I:l Dialed Number Pattern

[] = 600=

+*

Local Static Route

* RNA Timeout for Outbound Calls

[0 = ZZ7Z=

* Local Static Route

[] = 5151515100

* |Local Static Route
[] =9191=

* Local Static Route

[] = 8292=

*

Local Static Route

Step 4. Locate the " Patternsfor RNA timeout on outbound SIP calls' - thisiswhere you add the time CVP to
wait prior to initiating the Target re-query in ICM. Add the timer - 12 second and hit SAVE and DEPLOY
at the bottom. Y ou don't have to re-start CVP.
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PCCE - RNA Timeout Configuration

Step 1. Open the CCEAdmin and navigate to Routing Pattern.
Step 2. Select Route Settings.

Step 3. Add the timer to the RNA Timeout field.



Routsng Pattem®

Descnplon
Agent Extensions

Destinatan cucm 1. deloud, cisco.com

RiMA Timeout

CCE - Scripting
Step 1. Access Script Editor in Adminstrator server.
Step 2. Seelist of Scriptsif you added already, or you can create a new script.

Step 3. Navigate File -> New.

ER Script Editor - [Queueing_Thankyou {All Customers}.015 [Active Version][Browse]]
File Edit View Script Options Window Help

Mew... Ctrl+M ) ,
a1 N & E R < (@l 2"
I%@Qpen... Ctrl+ O | . =
i Close :I.E‘ .l L9
Close All |

Step 4. Change the Queue Type properties by righ click on the Queue to Skill Group node to enable
Target Requery and set the higher Priority.



Queus I Connection Labels

—(Jueue type Target references

Pricrity 5 ¥ Explicit target references

Using Skill Groups ™ Lookup target references by expression
¥ Byname

Target Requeny Enabled £ By D

Skill Group Route Translation Route Add Tangets. .
CUCK_1.Cisco_Voice. Biling_RT

Delete Bow

Target type:

Caf=dfcnfon | feafpd|—=

Business Entity: I [Mot applicable)

Enterprize target; I (Mot applicabls]

Pricrity: |5 _I?

¥ Enable target requeny

Step 5.Configure RequeryStatus variable in the script to validate the router requeuery status.



--% Queue to Skill Group
SKill Group No.
CUCM_1.Cisco Voice. Billing

2

Call RegueryStatus=

x

=2 If Properties (Read Only)

f lCnmment ] Connection Labels ]

Define condition:
———S
all. Reguery Status =0

R

Formula Editar...

| Cancel | Help

If there is an available agent, the Queue node sel ects the longest available agent from the configured skill
groups. If there is no available agent, the script then queues the call with apriority set in the node and
continues down the success exit of the node. When an agent becomes available, the Unified ICM always
selects the longest queued call from the ones with the highest priority. The RONA mechanism works as
follows:

* The Queue node selects an agent.

* |f the agent does not answer the call, then the script exits through the failure terminal of the Queue
node.

» Thelf node tests the RequeryStatus variable. If it has value of greater than zero, thisis arequery call
and the script re-queues the call.

* Inthe Scripting for RONA example above, it aso setsaflag using acall variable for reporting
purposes.

» Assuming that there are no agents available, the Queue node immediately exits through the success



terminal.

 If thisisarequired call, It increases the Queue Priority of the call so that it is handled before any other
callsin queue.

* It then enters the normal wait loop with RunScripts

Router Requery istriggered by the routing client (the CVP) when a No-Answer-Timer setting (RNATimeout) expireson CVP. After the CVP
VB RNATimeout expires the CVP --> VRU PG sends anEventReport = No Answer to the router. The router picks another target according to
the routing script and sends the Connect message to the CVP. The target might be another agent or it might be a VRU label to re-queue the call.

* The No Answer timer for Router Re-query is not controlled by the ICM, but by the switching fabric, which isthe CVP in this case. CVP
has a configurable No Answer timer, called RNATimeout. Set the RNATimeout to the desired number of seconds that the agent phone
should ring before being taken away. In any case, this timeout should be longer than the RONA time-out set in the Agent Desk Settings.

» Enable Requery on the node in the script that selects the first agent. Depending on the type of node used, the Requery mechanism select
anew target from the available agents or requires additional scripting. The ICM Script Editor Guide describes how Requery works for
the different nodes.

Note: Script design is outside the scope of this document. This only explains the minimum step
needed to requeue the call. For more details on this, see scripting and Media Routing Guide for Cisco Unified

ICM/Contact Center Enterprise

UCM - No Answer Ring Duration

Step 1. Accessthe DN of each Agent Extension and verify the call forward Ring No Answer timer which is
20 seconds by defaullt.

-Call Forward and Call Pickup Settings

Woice Mail

Calling Search Space Activation Policy

Forward All Cor |

Secondary Calling Search Space for Forward All

Forward Busy Internal or |

Forward Busy External [or |

Forward No Answer Internal Cor |

Forward No Answer External (or |

Forward Mo Coverage Internal or |

Forward Mo Coverage External [ ar |

Forward on CTI Failure (or |

Forward Unregistered Internal [or |

Forward Unregistered External or |
Mo Answer Ring Duration {seconds) |20 I
Call Pickup Group | = Nene = ~ |

Best Practice

Setup Agent Desktop Setting and ICM Scripting
» Enable RNA timer in CVP and UCM
Collect CVP logs with SIP traces


https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cust_contact/contact_center/icm_enterprise/icm_enterprise_12_6_1/User/guide/ucce_b_scripting-and-media-routing-guide_12_6.html
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cust_contact/contact_center/icm_enterprise/icm_enterprise_12_6_1/User/guide/ucce_b_scripting-and-media-routing-guide_12_6.html

» Collect CUCM logs
* Collect UCCE Rouer logs
» Collect Wireshark Traces

Note: You can use the Set Traces and Callect Logsin CCE link for collecting logs.



https://www.cisco.com/c/en/us/support/docs/contact-center/unified-contact-center-enterprise-1251/218125-set-traces-and-collect-logs-in-cce.html

